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SECTION 2:  Geopak – EFLHD Procedures 

 

2.1 - GEOPAK Plan & Profile Sheet Clipping (Geopak 8.x) 

Note -  The procedures outlined below is specific to creating plan & profile 
sheets, double plan, and separate plan and profile sheet for 11”X17” sheet 
sizes only. 

GEOPAK will create Plan sheets, Profile sheets, double plan sheets and 
plan/profile sheets. These sheets are generally created at 20, 40, 50, and 100 scale 
English (ft/in).      
Station range, drawing areas, and many other variables are contained in the sheet 
library files eflhd_Eng_sheets.psl.  The sheet library file contains many values specific 
to EFLHD such as cell library names and locations, specific sheet cells to be used, 
drawing scales, and a variety of text parameters. It cannot be modified by the user.     
 
The sheet library files for EFLHD projects are located at:  
M:\Engineering_Software\Cadd_resource_v8i\Plan&Profile_Shts\ 
The user copies this file into his/her working directory in order to run the Plan & Profile 
sheet smoothly. 

Prior to using the GEOPAK Plan and Profile Sheet Composition tool, three files need to 
be created.  Clip.dgn, Plan_motif.dgn and Profile_motif.dgn should be created to 
assure proper setup of plan and profile sheets.  Outlined below are the uses and 
instructions for creating each file.    

 

2.1.1 -  Create Clip Sheets and Motif Files 

Clip Sheet file Creating a drawing to display the sheet boundaries will allow the user 
to always have a visual representation of each sheet layout in relation 
to the others.  If the design changes, having this file will allow the user 
to move sheets around to better fit any design changes.  Create this 
sheet, and reference the map file, the horizontal alignment design file 
and profile design file into this new file. By referencing the overall 
design into the “01-ProjectName_Clip.dgn” file, any future design 
changes will be displayed in this new file, instantly showing the 
designer which sheets, if any, will need to be adjusted.   
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Motif files Motif files act as seed files for clipping plan and profile sheets. Each 
Motif file should be a blank file with the proper reference files attached, 
and the proper levels for each file turned on or off.  The Plan and 
Profile Sheet Composition tool will use these files when clipping each 
sheet and each clip sheet will have the correct files displayed with the 
correct levels on.  For example, if the plan view in a final plan sheet 
needs to show overall design, mapping, raster images, ROW, etc., 
with specific levels on or off for each of these files, you would only 
need to setup this combination once in the motif file.  This information 
would be used to create each sheet. These sheets should be named 
01-ProjectName-Plan_motif.dgn and 01-ProjectName-
Profile_motif.dgn. Create Plan_motif design file, attach each 
reference file that should be shown in the plan view, and turn on or off 
any levels to make the display look exactly like the final plan sheets in 
plan view.  Repeat these steps for the Profile_motif design file, 
referencing the profile sheet into the motif file. 

 

2.1.2 -  Plan/Profile sheets using GEOPAK 

 

Open the Clip.dgn and select the Plan and Profile Sheet Composition tool from 
Project Manager by selecting the button for Plan & Profile Sheets.  Select a Run or 
create a new Run.  
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A row of icons is available to access the dialog boxes listed below. The 
corresponding menu access selections are noted in parenthesis. 

 Sheet Composition (Tool>Sheet Composition) 

   Layout Sheet (Tools> Sheet Layout) 

 Clip Sheets (Tools>Sheet Clip) 

 Modify Sheets (Tools> Modify) 

                Sheet Number Manager (Tools>Sheet Number Manager) 

To the right of the icons are the Sheet Name list box and the scale. This list box 
contains a list of sheet types that are configured in the currently selected sheet 
library. 

Note :  This tool requires what GEOPAK refers to as "Sheet Libraries" be 
set up ahead of time. These sheet libraries contain a variety of Agency 
specific information. Cell Library names and locations, drawing scales, 
variety of text parameters, locations for the graphics to be clipped and 
placed within the sheet cells..…..... and many others.                                                                 
This documentation is not targeted at teaching the process of setting up 
the Sheet Libraries. It is already setup for EFLHD users. 

In order to complete the setup procedure you will need to know the scale you want 
the plan section of the P&P sheets to be drawn to. The following table outlines the 
available combinations of station range, horizontal, and overlaps for various scales 
that are commonly used in EFLHD.  
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                                              TABLE 1 

 Sheet name    Scale     Station Range     Horizontal   Overlap          Remark 

20 Plan/Profile  20          280         15           Multiple of 5    (Plan &Profile Sheet)                                           
20 Sep P/P  20          280                  15           Multiple of 5    (Separate Plan and Profile)    
20 Double Plan      20          280                      15                   Any           (Double Plan Sheet) 

40 Plan/Profile       40          550        15           Multiple of 10   (Plan &Profile Sheet)                                                 
40 Sep P/P        40          550                     15           Multiple of 10   (Separate Plan and Profile)    
40 Double Plan      40          550                     15                   Any            (Double Plan Sheet    

50 Plan/Profile       50          700                    12.5      Multiple of 12.5    (Plan &Profile Sheet) 
50 Single Plan       50          700                    12.5      Multiple of 12.5    (Plan Sheet) 
 
50 Sep P/P        50          700                    12.5      Multiple of 12.5   (Separate Plan and Profile)    
50 Double Plan      50                   700                    12.5                  Any           (Double Plan Sheet) 

100 Plan/Profile      100             1400        25           Multiple of 25    (Plan &Profile Sheet)                                                
100 Sep P/P         100               1400                     25           Multiple of 25    (Separate Plan and Profile)    
100 Double Plan     100               1400                     25                    Any            (Double Plan Sheet) 

200 Double Plan     200               2800       50              Any        (Double Plan Sheet) 
200 Plan/Profile     200               2800       50              Any        (Plan & ProfileSheet) 

 

 

2.1.3 - Example -Clipping an English project using 100 Scale Plan/Profile sheets. 

1. The following Plan Sheet Layout dialog box appears. Select 100 Scale Plan/Profile 
using the drop down arrow, and adjust the Scale field to 100 ft/in as shown below:  

               

 

 

2. From the pull downs, select Settings > Sheet Layout and adjust the Sheet Layout 
Settings as shown below and press OK: 
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3. Invoke the Sheet Composition dialog by clicking on the Sheet Composition icon 
from the Plan Sheet Layout dialog as shown below: 

                  

4. Modify the Sheet Composition dialog box as shown below:    

 

 

 

 

 

 

 

 

 

 

                                                                       < Use Table 1 to populate the Clip area 

 

                

Note - The dialog shown is settings for a 100 Scale PLAN/PROFILE “sheet 
style".” Other "sheet styles" have been created for English projects. The 
settings can be found at the end of this documentation.  

5. Invoke the Layout Sheets tools by selecting the Layout Sheets icon from the Plan 
Sheet Layout dialog as shown below: 

        

 

 

 

Select either of them:   

               .  

Note  
‐ Radial, it makes it very clear and clean. 
‐ Others, need some clean up but have more   
   control 
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                                           Layout Settings Tool 

6. Select Multiple Sheets from the dialog box and Select the GPK file by keying it into 
the “Job:” box, or by browsing using the file open icon. 

 

7. To populate the Plan Port Data dialog box, double click anywhere along the row for 
Port 1 in the Layout Settings dialog box and the following dialog box will be open.                                  

                           

8. Select the correct Chain and the appropriate Plan Motif file.  Press OK.   

9. To populate the Profile Port Data dialog box, double click anywhere along the row 
for Port 2 in the Layout Settings dialog box and the following dialog box will be 
open. 

                  

10. If a profile cell exists for the file that is referenced to the Clip.dgn file then click on 
Identify cell, place data point on the profile cell and accept.  Profile Data dialog fields 
can be populated using this method, or by manually entering in the required 
information. 
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11. Select the appropriate Profile Motif file.  Press OK.  

                     

   

12. GEOPAK will calculate the number of sheets to layout; number of sheets calculated 
will be placed on the button at the bottom right of the Layout Settings dialog box.  
The extend distance filed will allow the user to enter a value that will shift the 
clipping shapes backwards or forwards a given distance.  If the number of sheets is 
acceptable, press the Layout 8 Sheets button and GEOPAK will draw clipping 
shapes into the drawing.                                                                                                                           
The clipping shapes for both the Plan and Profile have now been placed as shown 
below: 

      

 

 

Close the Sheet Layout dialog by clicking on ”X” at the top right.                                                                   
Note: In order for the data to be clipped correctly, use the Sheet Layout Modify 
Tools.  Two most common types of modification supported are sliding the sheets 
and modifying the drawing area.  The drawing area cannot be increased in Length 
(Horizontal) or Height (Vertical) to exceed the Drawing Area setup in the sheet 
library. 

13. For extremely curved chains and steep vertical curves it may be necessary to modify the 
clipping shapes once the clipping shapes are placed.  Use the Modify Sheets icon, from 
the Plan Sheet Layout dialog  to invoke the Modify tools, as shown below: 
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14. Identify the Sheet (Clipping Shape) to be modified by clicking on the ID button and then 
data pointing the clipping shape or simply select it from the pick list, via the down arrow.   

 

 

                                                                                                      
The application is intelligent enough to know whether a Plan clipping shape or Profile 

clipping shape has been identified. When a Profile clipping shape is identified, the 
"Sheet Chord Offset" ”field changes to "Bottom Elevation",”(as shown above). When 
modifying the vertical position of a Profile clipping shape, toggle "Bottom Elevation" 
ON, type in the desired "bottom of the shape" ”elevation, or press Dynamic and move 

the shape up or down. 

15. Use the Sheet Number Manager tool to number sheets according to EFL standards.  To 
invoke the Sheet Number Manager tool, use the Sheet Number Manager icon, from the 
Plan Sheet Layout dialog, as shown below: 
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16. Click inside the white area anywhere on row one, hold down the shift key and click a 
second time anywhere on the last row.  Once all rows are selected, click on Edit Sheet 
Number as shown above. 

 

17. For EFL specific sheet numbering scheme where the sheets are numbered in sequence 
beginning with D1, complete the Edit Sheet Number dialog as shown below and press 
OK: 

         

                                                                                                       
Edit Sheet Number Tool 

18. When OK is pressed the Sheet Number Manager dialog will appear as shown below: 

           

 

Note -  With different runs for the same alignment clip, the user must 
recheck the sheet number and sequence. 
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19. Once the clipping shapes are placed and satisfactorily modified, invoke the Clip Sheets 
tool. Select the Clip Sheets icon from the Plan Sheet Layout dialog as shown below: 

 

 

            

20. Select the working directory in the Output File box.  Keep the sheet name prefix in the 
second field as blank, change the design file name latter after process. The Geopak 
appends the beginning sheet number to the “Sheet Name”. You most likely will have to 
rename this (or these) file(s) later as per EFLHD Naming Convention (eg. D-
LOP(2)_p&p.dgn). 

 

21. Select Orientation to Rotate View.  The sheet cell and the view are rotated and the 
clipped graphics maintains its coordinate grid intelligence, thus allowing for labeling right 
on the sheet. 

Note - EFLHD policy is to choose Rotate View, thus not to lose coordinate grid 
intelligence of the clipped graphics. 

  

22. Select Sheet per File to total number of sheets, thus sheet will be drawn in different 
models of the design file. EFLHD prefer to use all sheet shown in different models of one 
design file.    

Note - EFLHD prefers to use models for all the sheets in one design file. 
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23. Select the Sheet Range required from the pick list, using the drop down arrows.  Use the 
Sheet Number Manager Tool to renumber sheets to EFL specific sheet numbering 
scheme, (such as D1, D2, D3….) as explained earlier.   

24. Enter Labels and Annotation.  An example of a completed Clip Sheets dialog is shown 
below (illustrating the results of the completed Labels and Annotation fields)… when 
completed press Process Sheets. 

 

                                         

 

                                                 

Note - Keep 9 spaces between SE (Region) and PR (state), and 11 spaces 
between PR(state) and ERFO-RRP 10(2)[Project Number]. These spaces depend 
on the length of the project number characters. 
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2.2 -  Cross Section Sheets 

2.2.1 -  General Information: 

The Cross Section Sheet dialog can be accessed by selecting Application > GEOPAK 
> Road > Cross Sections > Cross Section Sheet Composition from the Microstation 
pull down menu, or from the GEOPAK Road tool palette, or the Road Project dialog as 
shown below. 

  

 Click on the Cross section Sheets icon as shown above. 
 

Note - When you access the Geopak Cross section Sheets function from 
the Road Project dialog box, you will be prompted to select a run. From 
the Select Run dialog box, select Run > New to create a new cross section 
sheet run. The New Run Name dialog box is opened. Key-in the Run Name 
and an optional Description. Select OK. The new run is created and is 
available for selection from the Select Run dialog box. From the Select 
Run dialog box, select the name of the run that you would like to open. 
Select OK to open the run.  
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 The Cross Section Sheet Composition dialog box will be open as shown below.   
 

                        

 

 The following step-by-step procedure refers to the marked-up graphic of the main 
Cross Section Sheets Composition dialog shown above.   
 

(1) Cross Section Sheet Composition’s file name is always displayed on the top of the 
dialog box.  This file is the Sheet Library, which contains the parameters for the Cross 
Section Sheets and is saved in a Sheet Library file. Sheet layout configurations can be 
saved in the sheet library and recalled for future use. Sheet libraries have a default 
extension of “*.xssl ”.  

The sheet library “EFLHD_xssheet.xssl” has been configured for use with EFLHD’s 
Standard Cross Section Sheet Cells. This sheet library can be obtained from the 
following directory;          

M:\Engineering_Software\Cadd_resource_v8i\Cross-Section_Shts\          

 Note - For Consultants, this file is available through the 
CADD_Resources_V8.zip download.   

 

(2) Active Cross Section Sheet:  EFLHD has defined Cross Section sheets in different 
formats and scales.  Select the format and scale from the Table 1:  

1 

3 

2 
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XS Sheet Format 

 

 

English Scale Active Cross 
section sheets 

Notes 

 

 

1”=30’ 

  xs_1xH_30_eng 

 

1"=20'  xs_1xH_20_eng 

 1"=10' xs_1xH_10_eng 

 

 

 

1”=30’ 

  xs_1xV_30_eng 

 

1"=20'  xs_1xV_20_eng 

 1"=10' xs_1xV_10_eng 

 

1"=20'  xs_2xH_20_eng 

 

 1"=10' xs_2xH_10_eng 

 

1"=20'  xs_2xV_20_eng 

 

 1"=10' xs_2xV_10_eng 

Table 1 
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(3) The left side of the Cross Section Sheet Composition dialog box contains a list of 
parameters. When a parameter is selected, a graphic explanation of the parameter 
appears in the lower left portion of  the dialog box and key-in fields for each variable 
appear to the right. 

XS DGN File, Sheet DGN File, and Sheet Labels parameters need to be edited by 
the user. The rest of the parameter is already set through the EFLHD’S Sheet library 
file.  

2.2.2 -  Create Cross Section Sheets: 

 Step I 

- Copy sheet library file “EFLHD_xssheet.xssl” from the 
“M:\Engineering_Software\ Cadd_resource_v8i\Cross-Section_Shts\”   into your 
project working directory.  

 Note - For Consultants, this file is available through the 
CADD_Resources_V8.zip download.   

- Create a new MicroStation design file for your Cross Section Sheet in your working 
directory as explained in Section 4.1.2. Give the name of the file according to the 
Naming Convention as explained in Section 2.2 (e.g. T01-LOP(2)_xss.dgn)  

 Step II 

- Open the cross section file that contains the cross sections that need to be placed 
on sheets. 

- Open the Cross section sheets dialog through your Road Project dialog (shown in 
General Information earlier).  The Cross Section dialog will appear as shown below. 
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 Step III 

- Attach the cross section sheet library via the menu item File>Sheet Library>Attach 
(as shown below ) and select “EFLHD_Eng_xssheet.xssl” from your working 
directory. The name of the attached Sheet Library is shown in the title bar.                       
  

 

 Step IV 

- After attaching the EFLHD cross section sheet library, the Active Cross Section 
Sheet option will display the sheet layout options shown below.  
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-  Select the cross section sheet layout from the pull down menu of Active Cross 
Section Sheet. Use Table 1 to select the sheet layout. 

 

 Step V 

-  Select XS DGN File option in the left side of the menu. The Cross Section Sheet 
dialog in the right side will appear as shown below.               

 

 

-  XS DGN File field in the right side of the menu is used to specify the name of the 
design file containing     the original cross sections. Select the cross section file by 
use of the select XS DGN File icon. The Chain and stationing will be filled out 
automatically and the software will find all elements within the confines of the cross 
section cell. 
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 Step VI 

-  Select Sheet DGN File option in the left side of the menu. The Cross Section Sheet 
dialog will appear in the right side as shown below.               

                               

-  Sheet DGN File field in the right side of the menu is used to specify the name of the 
design file where GEOPAK will compose the cross section sheets.  Select the cross 
section sheet file created in STEP I by use of the select Sheet DGN File icon.  Keep 
the rest of the key-in field of this option as default setup.   

Note - GEOPAK does not create the cross section sheet file. The file 
must be created prior to processing.  
 

 Step VII 

-  Select Sheet Labels option in the left side of the menu. The Cross Section Sheet 
dialog will appear as shown below.  
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-  Sheet Labels field in the right side of the menu has a table with Name, Label, X 
Coordinate, Y Coordinate, Display, and Plot column.  EFLHD Sheet library has 
already been configured to place Sheet Labels on EFLHD Standard cross section 
sheet. Designer is only responsible for changing the field of Label column. Edit this 
field by selecting the row of the table and then click on the cell which needs to be 
change. The information for the Labels used by EFLHD is shown as below.  

 

 

      Note - Sheet Number have Prefix T or U or... 

 

 Step VIII 

 -  Save your work by using File>Sheet Library>Save.    

 -  Now click on Layout Sheets to process the cross section sheets layout.  

 

2.3 - Draw Graphics Elements as Pay Items Using D&C Manager  

 

2.3.1  - Intoduction: 

The D&C Manager is also used by Geopak to standardize graphics elements for 
drafting and pay items quantities.  

EFLHD Standard D&C Manager database “EFLHD_ENGLISH.ddb” has been 
developed by EFLHD to draw the graphics elements into the plan view sheets 
according to the EFLHD’s symbols and abbreviations sheet and compute the 
quantity of the same. 
 
 

  Agency Name 

       Begin Sta., and End Sta. 
 (Don’t change) 

      Road Name 

                Region 

                      State 
         Sheet #                  Project # 
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 The D&C Manager database “EFLHD_ENGLISH.ddb” is located in the following 
directory:  
M:\Engineering_Software\CADD_Resource_V8\X_30\Standards\DDBS\English\ 
 

Note - There are two D&C Manager Databases available in that 
directory, EFLHD_ENGLISH.ddb and V8_ENGLISH.ddb. The 
V8_ENGLISH.ddb database has been developed by FLH and is used to 
draw chain, chain stationing, profiles, and the elements for use with 
X30 criteria (for proposed cross section). 

 

 The D&C Manager can be accessed by using the MicroStation pull downs:  
 Applications > Geopak > Road > Design & Computation Manager ... or 

from the Road Tools icon as shown below:  

                         

 

 

 

 The default D&C Manager database is attached as V8_English.ddb which is 
set by EFLHD Configuration setup. The user needs to change the database. 

 Select File > Open from the D&C Manager dialog box to access 
“EFLHD_ENGLISH.ddb” from the 
“M:\Engineering_Software\CADD_Resource_V8i\X_30\Standards\DDBS\Englis
h\” directory. 

 The currently selected database is displayed in the dialog as shown below. 
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 Note - The D&C Manager database is a password protected file 
and cannot be edited by the designer. Suggestions or request for 
enhancements should be forwarded to the CADD Coordinator at 
EFLHD. 

 The basic component of the hierarchical tree is the Category. The database 
EFLHD_ENGLISH.ddb contains four sub categories: Roadway Design, 20 
Scale, 40 Scale, 50 Scale and 100 Scale (These categories will be selected 
according to the scale of the plan sheet “11X17 sheet size”). A double-click on 
the Roadway Design, 100 Scale category will reveal several categories as 
shown below. 
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2.3.2 - Drawing Custom Graphical Elements into Plan View  

 A double-click on the Erosion Control category reveals several items as shown 
below: 

 

 Similarly each sub-category has several items within it. 
 The items contain specific functions related to defining element symbology or 

placing pay items. These items will be used to set drafting standards for 
MicroStation commands and the resulting graphics are tagged with a pay item 
attribute that can be used to calculate plan quantities. 

Note - All item numbers are set according to the Pay Item 
number as per FP-03, US Customary Unit.  
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 The Place Influence toggle is used to override the currently active MicroStation 
symbology settings. The Place Influence toggle button is located on the D&C 
Manager Tool Setting dialog as shown below. 

                               

 Note - When the Place Influence toggle is activated, elements 
are drawn using the level, symbology and attributes as 
defined in the GEOPAK database “EFLHD_ENGLISH.ddb”. 

 By toggling on Place Influence, you can use MicroStation commands to place 
elements utilizing the drafting standards established for the currently selected 
item in the D&C Manager database.  

 If you double click the name of any item in EFLHD’s D&C Manager that is used 
to place a cell, the place cell command will be automatically selected. If Place 
Influence is on, the cell will be floating on your cursor, ready to place in the 
design file. Similarly, if you click any item that is used to place line, the place 
line will be automatically selected. The line will be placed using the level, color, 
weight and custom line style setting associated with the line item. 
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2.3.3 -  Generating Quantities in D&C Manager 

When generating quantities, a collection set can be defined for computation and 
easy recall. Collection sets can consist of entire categories or individual items. 

Step I:             

 Click on the Compute icon. 

                                      

 

 

 

 

 

 

 

 

 

 

 

 

 Select the Category, and then with a right click, select the Add to 
Collection option from the pop-up menu. The designated category 
appears in the Collection list box located at the bottom of the dialog box. 
D&C Manager computes quantities for every item found in the selected 
Category as well as any Sub-categories. 

Note - To add individual items, select an individual Pay Item with a 
single click, and then right click on the highlighted item, selecting 
the Add to Collection option from the pop-up menu. You can also 
double click on the item to add the item into a collection set. 

 

 Collection box 

     Category 

  Sub-category 
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Step II   

 Plan Quantity Computation dialog box as shown below will appear when 
user selects the Compute icon in Step I. 

                                 

 Fill in the required information in the Plan Quantity Computation dialog 
box then click on Compute Quantities. 

Note -  The “Extents” determines which elements are included in 
the set. In addition to the extents, if the Range option is active, 
the element must exist within the extents and range (distance left 
and right of the baseline) for the element to be computed. 

 Computation Results are as shown below: 
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 The dialog box displays the pay items and associated computed quantity. 
The user has the option to select the format of the quantity output. Now 
click on the Export, a text file will be created on the selected directory, 
which can be opened by any text editor. 
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Appendix A 
 
 

More Help for Editing Redefinable Variables 

 

Note - Plan View Override Elements overwrite all 
Redefinable Variable values 

 

_d_DefinePavementLayers 

This variable defines the number of proposed surfacing layers that are to be closed off 
vertically, and not “daylighted” to the shoulder foreslope in guardrail or aggregate 
shoulder locations.  Use the _d_DefinePavementLayers variable where guardrail or 
aggregate shoulder is present.  

     The default value = 1 

EXAMPLE:                           EXAMPLE: 

       if (Sta >= 0+00 R 1) then                 if (Sta >= 0+00 R 1) then 

    _d_DefinePavementLayers = 1                _d_DefinePavementLayers = 2 

 

 

 

 

_d_FirstFullLengthLayer 

This variable defines the number proposed surfacing layers to “daylight” to the shoulder 
foreslope.  Use the _d_FirstFullLengthLayer variable where no guardrail or aggregate 
shoulders are present.  

The default value = 1 
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EXAMPLE:                      EXAMPLE: 

  if (Sta >= 0+00 R 1) then                if (Sta >= 0+00 R 1) then 

 _d_FirstFullLengthLayer = 1                   _d_ FirstFullLengthLayer = 2 

 

 

 

_s_PavementClosureOption 

This variable sets how the edge of pavement is to be closed if not “daylighted” to the 
shoulder foreslope (i.e. _d_FirstFullLengthLayers   = 2 or more).  The option was created for 
the different needs of the three FHWA divisions.  Use a 1:1 pavement edge for typical 
Central Federal Lands (CFL) projects and a vertical edge for Easter Federal Lands (EFL) 
projects.  Use ^V^ for a vertical closure or ^S^ for a one to one slope closure.  The selected 
closure option also applies when guardrail is present. 

The default value = ^V^ 

EXAMPLE:                       EXAMPLE: 

  if (Sta >= 0+00 R 1) then                  if (Sta >= 0+00 R 1) then 

  _s_PavementClosureOption = ^V^               _s_PavementClosureOption = ^S^ 
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_d_SurfacingLayer1Thickness 

This defines the thickness of the first layer in the proposed pavement structure.  Use this 
variable for all projects with a proposed driving surface.  The first surfacing layer thickness 
must be greater than zero and expressed in master units.   

The default values = 4/12 or .100 

EXAMPLE:  

  if (Sta >= 0+00 R 1) then 

  _d_SurfacingLayer1Thickness = 3/12 

 

 

_d_SurfacingLayer2Thickness to _d_SurfacingLayer5Thickness 

These variables define the thickness of additional layers in the proposed pavement structure.  
Use these variables when more than one proposed pavement structure layers are desired.  
The surfacing layer thicknesses 2 through 5 may be set to zero. 

Note:  Cross Sections with guardrail will not be drawn correctly, without 
at least two layers of surfacing. The fill slope will begin at the top of the 
foreslope, instead of the bottom. One work around for this is to use two 
layers of surfacing, and then delete out the ‘dummy’ layer. For 
consistency in Staking Reports, use a ‘dummy’ layer through out the 
entire project.  

 

 

_d_WedgeDepth 

This variable defines the depth of the wedge adjacent to the non-daylighted surfacing 
layer(s) and is expressed in master units.  Use this variable for projects that require a 
different shoulder material other than a surfacing lever.  When used, the wedge will be drawn 
with different symbology (shoulder backfill) so that earthwork values can be separated.  If the 
wedge depth is set to a value greater than the depth of the surfacing layers which are not 
“daylighted”, the wedge will be drawn to the same depth as the surfacing layers which are 
not “daylighted”.  If no wedge is desired, set the value to zero. 

The default value = 0 (no wedge) 
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EXAMPLE:   In this example, the first layer thickness is 3/12, the second layer is 6/12 and 
the third layer thickness is 8/12. 

  if (Sta >= 0+00 R 1) then        if (Sta >= 0+00 R 1) then 

   _d_WedgeDepth = 10/12          _d_WedgeDepth = 10/12   
     

 

 

with:  _d_FirstFullLengthLayer = 2  with:  _d_FirstFullLengthLayer = 3  

  if (Sta >= 0+00 R 1) then        if (Sta >= 0+00 R 1) then 
{         { 

   _d_WedgeDepth = 10/12          _d_WedgeDepth = 10/12 
}         } 
          

 

 

with:  _d_FirstFullLengthLayer = 2  with:  _d_FirstFullLengthLayer = 3  
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_d_ShoulderForeSlope 

This variable defines the shoulder foreslope and is expressed in a rise:run format.  All 
proposed cross section use this variable.  The slope will always be assumed to be negative 
in value.     

The default value = 1:4 

Note: The shoulder foreslope variable can be overridden with 
plan view overrides.  

EXAMPLE: 

  if (Sta >= 0+00 R 1) then 
{ 

  _d_ShoulderForeSlope = 1:2 
 }           
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_s_RecoverableShoulderForeSlope 

This variable is used to override the ‘normal’ shoulder foreslope when a recoverable slope is 
used.  Only use this variable when the recoverable slope is preferred over the shoulder 
foreslope.  Set this variable to ^Yes^ to override the shoulder foreslope variable with a 
recoverable slope.  If set to ^No^, the shoulder foreslope will equal the shoulder foreslope 
variable.   

This variable must be used in conjunction with the redefinable variable 
_d_RtRecoverableSlopeDist (or Lt). If these variables are set to zero, no override will occur.  
The slope of the recoverable distance is set with the Redefinable variable 
_d_RtRecoverableSlope (or Lt).  The use of the variable _d_RtSecondarySlope is optional, if 
the value is set to 0:0 then the secondary fill slope will be selected from the fill slope criteria 
table. 

The default value = Yes 

EXAMPLE:   

   if (Sta >= 0+00 R 1) then 
         { 
             _s_RecoverableShoulderForeSlope = ^Yes^  
          } 
 

 

   if (Sta >= 0+00 R 1) then 
         { 
            _s_RecoverableShoulderForeSlope = ^No^  
         } 
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_d_SubExDepth and _d_SubExType  

These variables set the location, depth and type of subexcavation to be drawn in the 
proposed cross sections.  Use these variables whenever it is necessary to show 
subexcavation in cross section views or to accurately measure the earthwork volumes 
associated with subexcavation. 

The variable _d_SubExDepth defines the depth of subexcavation.  Use the variable in all 
locations of subexcavation regardless of the type of subexcavation defined (Type 1 or 2) 
which also must be defined. The variable needs to be expressed in master units and no 
negative sign is required. The depth is measured differently, depending upon the type of 
subexcavation selected; see the description of _d_SubExType for an explanation. 

 The default value = 0 

EXAMPLE: 

  if (Sta >= 0+00 R 1) then 
{ 

  _d_SubExDepth = 24/12 
 }      
 

The variable _d_SubExType defines the type of subexcavation.  Use in conjunction with 
_d_SubExDepth for all subexcavation locations.  Type 1 subexcavation, which is defined as 
below proposed subgrade, is invoked by setting the variable equal to 1.  Type 2 
subexcavation, which is defined as below existing ground, is invoked by setting the variable 
equal to 2. 

The default value = ^2^ 

Note: The subexcavation type and depth variables can be overridden 
with plan view overrides.   

EXAMPLE 1:  Note:  The bottom of the Type 1 subexcavated area is parallel to the 
proposed subgrade and it automatically ends when it intersects the fill slope or the bottom of 
the ditch.  No plan view elements are required. 

  if (Sta >= 0+00 R 1) then 
{ 

  _d_SubExType = ^1^ 
 }  
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Subexcavation quantity = Crosshatched area 

Subexcavation Backfill quantity = Crosshatched area + Hatched area 

 

EXAMPLE 2:  Note:  Type 2 Subexcavation requires two plan view lines (LV= 
P_RDW_Edge_of_Subexcavation) to define the offset distances from centerline. The bottom 
of the subexcavated area is horizontal and the depth is measured from the existing ground 
on the left hand side. 

   if (Sta >= 0+00 R 1) then 

{ 

  _d_SubExType = ^2^ 

 } 

 

Subexcavation quantity = Hatched area + Crosshatched area 

Subexcavation Backfill quantity = Crosshatched area 

 



 
 

[Type	text]	 Page	2‐37	
 

EFLHD CADD Procedures Guide – GEOPAK V8i Edition 
Chapter 2 –                        
GEOPAK V8i ‐ EFLHD Procedures

 

_d_MaxWidenSearchDistance 

This variable defines the distance in master units to search for a pavement widening line in 
plan view.  The distance is measured from centerline.  This variable is used when cross 
sections may cross other edges of pavement widening from other roads or in switchbacks.  
Extraneous lines will cause errors when proposed cross sections are drawn.   

The default values = 12 (ft) or 3.6 (m) 

EXAMPLE: 

  if (Sta >= 0+00 R 1) then 
{ 

  _d_MaxWidenSearchDistance = 40 
 } 
 

_d_BackofCurbSearchDistance 

This variable defines the distance in master units to search for the back of Type 1 or Type 2 
curb in plan view.  The distance is measured from the edge of traveled way.  Type 1 and 
Type 2 curb lines in plan view act as a trigger and exact horizontal position is not important.  
Use this variable to work with the plan view offset values drawn. 

The default values = 3 (ft) or 1 (m) 

EXAMPLE: 

  if (Sta >= 0+00 R 1) then 
{ 

  _d_BackofCurbSearchDistance = 40 
 } 
 

_d_Type3CurbSearchDistance 

This variable defines the distance in master units to search for Type 3 curb in plan view.  The 
distance is measured from centerline.  Type 3 curb lines in plan view act as a trigger and 
exact horizontal position is not important.  Use this variable to work with the plan view offset 
values drawn. 

The default value = 20  

EXAMPLE: 

  if (Sta >= 0+00 R 1) then 
{ 

  _d_Type3CurbSearchDistance = 20 
 } 
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_d_ClrZoneRecovCutDist and _d_ClearZoneCutSlope 

These redefinable variables are used define cut situation clear zone distances and allowable 
slopes.  Additionally, these variables are used to label or check proposed cut slopes that do 
not meet the defined distance or exceed the allowable cut slopes within a clear zone.  Any 
cut slope that exceeds the allowable slope within the defined clear zone will be labeled.  The 
criteria will also label a case where the clear zone distance is not met.   

Note:  Use of these variables does not draw a “barn roof” clear zone 
section.  These variables are used where “barn roof” sections are not 
proposed. 

The variable _d_ClrZoneRecovCutDist defines the distance to perform the check from the 
top of the shoulder foreslope to the outer edge of the clear zone in a cut situation.  

The variable _d_ClearZoneCutSlope sets the allowable clear zone slope in a cut situation.   

If no check of the slopes is required, leave the _d_ClrZoneRecovCutDist variable set to 0 
(default). 

EXAMPLE: 
  if (Sta >= 0+00 R 1) then   

{ 
     _d_ClrZoneRecovCutDist = 10  

}  
 

 

 

with:  _d_ClearZoneCutSlope = 1:6 
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_d_ClrZoneRecovFillDist and _d_ClearZoneFillSlope 

These redefinable variables are used define fill situation clear zone distances and allowable 
slopes.  Additionally, these variables are used to label or check proposed fill slopes that do 
not meet the defined distance or exceed the allowable fill slopes within a clear zone.  Any fill 
slope that exceeds the allowable slope within the defined clear zone will be labeled.  The 
criteria will also label a case where the clear zone distance is not met.   

Note:  Use of these variables does not draw a “barn roof” clear zone 
section.  These variables are used where “barn roof” sections are not 
proposed. 

The variable _d_ClrZoneRecovFillDist defines the distance to perform the check from the top 
of the shoulder foreslope to the outer edge of the clear zone in a fill situation.  

The variable _d_ClearZoneFillSlope sets the allowable clear zone slope in a fill situation.   

If no check of the slopes is required, leave the _d_ClrZoneRecovFillDist variable set to 0 
(default). 

EXAMPLE: 

 if (Sta >= 0+00 R 1) then   
{ 

_d_ClrZoneRecovFillDist = 10  
}  
     

 

with:  _d_ClearZoneFillSlope = 1:6 
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_d_LtRecoverableSlopeDist and _d_LtRecoverableSlope and _d_LtSecondarySlope 

These redefinable variables are used to create a safe recovery area or “barn roof” section in 
cut and fill situations on the left side of the roadway.  Use these variables to build safety into 
the proposed roadway or when the defined clear zone requirements are not met. 

The variable _d_LtRecoveralbeSlopeDist defines the horizontal distance for the recoverable 
slope and is measured from the top of the shoulder foreslope or edge of pavement if no 
shoulder is proposed. 

The variable _d_LtRecoverableSlope defines the slope for the recoverable slope and is 
expressed as negative rise:run values.   

The variable _d_LtSecondarySlope defines a secondary slope and is used to set fill slopes 
when recoverable slopes are used.  Use this variable if it is necessary to have a constant fill 
slope or if the standard fill slopes are not desired.  Any value, expressed in a rise:run format, 
other than 0 (default) will override the fill slope table.  If the secondary slope is flatter that the 
recoverable slope, the recoverable slope will be used instead.  It is not necessary to set this 
variable when using recoverable slopes 

If no recoverable slope is desired, set _d_LtRecoverableSlopeDist = 0 (default). 

EXAMPLE: 

if (Sta >= 0+00 R 1) then  
      {     with:   _d_LtRecoverableSlope = -1:6 
 _d_LtRecoverableSlopeDist = 10     _d_LtSecondarySlope = -1:3 
       }              _d_RecoverableShoulderForeSlope = 
^Yes^ 

Note :  If _d_RecoverableShoulderForeSlope is set to ^No^, then the 
shoulder foreslope is controlled by the _d_ShoulderForeSlope variable. 

 

      Cut Situation          Fill Situation 

Note:  In the cut situation, the secondary slope does not override the 
ditch slope, which is controlled by the redefinable variable 
_d_DitchForeslopeLt 
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_d_RtRecoverableSlopeDist and _d_RtRecoverableSlope and _d_RtSecondarySlope 

These redefinable variables are used to create a safe recovery area or “barn roof” section in 
cut and fill situations on the right side of the roadway.  Use these variables to build safety 
into the proposed roadway or when the defined clear zone requirements are not met.  See 
the description above for the Left side variables. 

 

_d_FillSlope1 and _d_ FillSlope1Height (and Fill Slopes 2 through 9) 

These redefinable variables define the fill slope selection criteria, based on the height 
of the fill slope. The slope is expressed in a rise:run format.  The slope will be 
assumed to be negative.  The fill height is a maximum height for the corresponding 
slope and is expressed in master units. 

Note: All fill slope variables can be overridden with plan view overrides.  

 

EXAMPLE:       EXAMPLE: 
 

  if (Sta >= 0+00 R 1) then     if (Sta >= 0+00 R 1) then   
{           { 
  _d_FillSlope1 = 1:6    _d_FillSlope1Height = 2.0 

   }            } 
   

In the example, all fill slopes with a height of two feet or less will be drawn at a -1:6 
slope. 

 

_d_CutSlope1 and _d_ CutSlope1Height (and Cut Slopes 2 through 9) 

These redefinable variables define the cut slope selection criteria, based on the height of the 
cut slope. The slope is expressed in a rise:run format.  The slope will be assumed to be 
positive.  The cut height is the maximum height for the corresponding slope and is expressed 
in master units. 

Note: All cut slope variables can be overridden with plan view overrides.  

EXAMPLE:       EXAMPLE: 
  if (Sta >= 0+00 R 1) then     if (Sta >= 0+00 R 1) then   

{           { 
  _d_CutSlope1 = 1:6    _d_CutSlope1Height = 2.0 

   }            }  
In the example, all cut slopes with a height of two feet or less will be drawn at a 1:6 slope. 
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_d_DitchForeslopeLt and _d_DitchForeslopeHeightLt and _d_FlatBottomDitchWidthLt 

These redefinable variables set the design parameters of the left roadside ditches.  Use 
them to vary the heights, slopes and shapes of ditches throughout a proposed project. 

This variable _d_DitchForeslopeLt variable defines the slope of the left ditch from the 
subgrade hinge point in a rise:run format. The slope will always be assumed to be negative. 

The default value = 1:4  

EXAMPLE: 
  if (Sta >= 0+00 R 1) then   

  { 
     _d_DitchForeslopeLt = 1:4 

     }  
     

This variable _d_DitchForeslopeHeightLt defines the vertical height of the left ditch from the 
subgrade hinge point in master units. 

 The default values = 1.5 (ft) and 0.5 (m)  

EXAMPLE 1: 
  if (Sta >= 0+00 R 1) then   

  { 
     _d_DitchForeslopeHeightLt = 2.0 

     }      
   

 

 

Note: The ditch foreslope and the ditch foreslope height variables can 
be overridden with plan view overrides. 

The variable _d_ FlatBottomDitchWidthLt defines the width of the left flat bottom ditch and is 
measured in master units.  This variable is used when a flat bottom ditch is preferred over a 
“V” ditch. If a “V” ditch is desired, leave this variable set to zero (default). 

Note: The flat bottom ditch width variable can be overridden with plan 
view overrides.  
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EXAMPLE 2: 
  if (Sta >= 0+00 R 1) then   

  { 
     _d_FlatBottomDitchWidthLt = 2 
  } 

  

 

 

_d_DitchForeslopeRt and _d_DitchForeslopeHeightRt and 
_d_FlatBottomDitchWidthRt 

These redefinable variables define the dimensions of the ditch on the right side. See the 
descriptions above for the left side ditch variables. 

Note: The all these variables can be overridden with plan view overrides.
  

 

_d_GroundDropOffSearchDistance and _d_GroundDropOffSampleDistance 

These variables are used to define how and when a ditch is created in a fill situation.  If the 
shoulder subgrade point is above ground and the bottom of the ditch foreslope is below 
ground, the criteria will check to see if the ground slopes to a point below the defined ditch 
bottom.  If this is the case, a fill slope will be drawn intersecting existing ground and a ditch 
will not be drawn.    

Note:  The bottom if the ditch foreslope is set by the variable for ditch 
foreslope height. 

The variable _d_GroundDropOffSearchDistance defines the distance in master units used to 
determine how far to search to see “if” the ground falls below the ditch bottom in a fill 
situation.  This distance is defined in master units and is measured horizontally from the 
shoulder subgrade point.  

 The default values = 50 (ft) and 15 (m) 
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EXAMPLE: 
 
  if (Sta >= 0+00 R 1) then   

  { 
     _d_GroundDropOffSearchDistance = 50 
  }  

 

The variable _d_GroundDropOffSampleDistance sets the distance in master units used to 
determine the increment to move along the ground to determine if the ground falls off below 
the bottom of ditch in a fill situation.  

The default values = 1 (ft) and 0.3 (m) 

 EXAMPLE: 
 
  if (Sta >= 0+00 R 1) then   

  { 
     _d_GroundDropOffSampleDistance = 1 
  } 
 

 

_d_DaylightSlope and _d_DaylightWidth and _d_DaylightOption 

These variables are used to define the slope width and type of “daylighted” slope that is 
drawn.  “Daylighted” slopes are used in cut situations when there is a possibility to grade out 
a slope instead of having a roadside ditch.   

_d_DaylightSlope defines the slope in rise:run format to draw the daylight slope. 

 The default value = -1:20 

EXAMPLE: 
  if (Sta >= 0+00 R 1) then   

  { 
     _d_DaylightSlope = -1:20 
  } 
  

_d_DaylightWidth is a redefinable variable that defines the maximum width of the 
“daylighted” slope measured horizontally from the bottom of the ditch foreslope in master 
units.  Use the variable in cut situations where there is a choice to either create a ditch or 
grade out to an existing slope. 

The default values = 30 (ft) and 10 (m) 
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 EXAMPLE: 
 
  if (Sta >= 0+00 R 1) then   

  { 
     _d_DaylightWidth = 10 
  }  
 
 
 
 

_d_DaylightOption defines the method of daylighting a slope. Use ^S^ to daylight from the 
shoulder subgrade; use ^D^ to daylight from a ditch foreslope and use ^N^ if no daylight 
slope is desired. 

The default value = ^D^ 

 EXAMPLE: 
  if (Sta >= 0+00 R 1) then    if (Sta >= 0+00 R 1) then 

  {           { 
     _d_DaylightOption = ^S^    _d_DaylightOption = ^D^ 
  }           } 
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_d_RockSlopeLT and _d_RockSlopeRT 

These redefinable variables are used to define the slope of the lower portion of a broken 
back cut slope.  The slope of the upper portion of the broken back cut slope is defined by the 
slope selection criteria or by plan view overrides.  The elevation where the change in slope 
occurs is triggered by a line drawn on the cross section with the D&C Manager.  

 The default value = 4:1 

EXAMPLE: 
 
  if (Sta >= 0+00 R 1) then   

  { 
     _d_RockSlopeLt = 8:1 
  } 
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_s_ExcavationLimit and _s_ExcavationLimitOffset 

These redefinable variables are used to label the limits of excavation. If no labels are 
desired, set the variable _s_ExcavationLimit to ^N^.  The offset of the label can be positive 
(outside of tie) or negative (inside of tie).  

  EXAMPLE: 
 

if (Sta >= 0+00 R 1) then    if (Sta >= 0+00 R 1) then 
  {           { 
     _s_ExcavationLimit = ^Y^          _s_ExcavationLimitOffset = 0 
  }           } 
 

 

 

Note:  Earthwork processes require the use of Excavation Limit labels. 
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Appendix B 
 

Using the Safety Edge Shoulder_SE.x30 Criteria File 

 
In Project Manager > PROPOSED CROSS SECTIONS Tool 

Scroll down to Shape Clusters, Highlight the RT Side Slope Condition, in the Criteria 
Files window, 

 

 

 

1. Delete the shoulder.x30 criteria file (answer “yes” to the prompt)  
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2. Add the shoulder_SE.x30 criteria file (you may have to navigate to 
M:\Engineering_Software\Cadd_resource_v8i\X_30\Typicals\English 
with the Select button) 

 

 

 

Highlight and Hit “To Criteria” 

Close the dialog with “Done” 

 

 

This will add the Safety Edge criteria file shoulder_SE.x30 at the bottom of the list. 

It is IMPORTANT that the sequence of the criteria files is maintained for 
the order in which Geopak wants to build your cross sections. 

Use the “Up” button to move the file back into its proper order (directly 
AHEAD of the slopes.x30 criteria file)   

 

 

**** REPEAT THE SAME FOR THE LT SLOPE CONDITION **** 
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Scroll down to Redefinable Variables, find and highlight the _s_PavementClosureOption 
Variable. 

  

 

Hit Edit to open the Variable Editor. 

Edit the option to ^S^ for the pavement 
to close with a slope rather than a 
vertical line.   
 

Save the change. 

(although the description still says “one to one slope” , the shoulder_SE.x30 we just added 
will build a 30 degree edge) 

 

Save Settings and 

(re)Run your cross sections. 

       Ex.; 

 

        

 



 
 

[Type	text]	 Page	2‐51	
 

EFLHD CADD Procedures Guide – GEOPAK V8i Edition 
Chapter 2 –                        
GEOPAK V8i ‐ EFLHD Procedures

 

Appendix C 

Miscellaneous Microstation Tips 

 

 

CREATE HYPERLINKS IN DGN 

• Pull down the Tasks menu to Drawing Composition.  
 

• Select Organize >  Add a Link to an Element. 
 

 
 
 
 

• Options are shown for linking from a file, keying in the path or URL (web). 
• Select From File. 
• Navigate to the file you want linked.  Highlight the file. 
• Hit Add. (multiple files may be added)  > Open. 
• Highlight the file in the Link Target window.  
• Hit OK. 
• You are prompted to identify the element. 

     Select the element or text and accept. 
• Hold the right-click and select Follow Link. 
• The link OPENS ! 

 
Link to other dgn’s, pictures, spreadsheets, 
WORD documents, websites, etc. 
 
 
 
To remove them; 
Go to Element > Information to delete the links. 
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MODIFY ACTIVE LINESTYLE SCALE 

• This will allow you to scale a line style without redrawing it. 
 

• Go to the Change Element Attributes Tool.  
 

 
 

 
 

• Pull down to Modify Line Style Attributes. 
 
 
 
 
 
 
 

• Select Scale. 
• Toggle on Scale setting.  Set your desired scale factor. 

 
(this is a scale factor, not an active scale setting for your file or model) 
(for additional information on setting up/resetting line style scales, see 
Chapter 5 in the V8i CPG) 
 

• Identify the element and Accept. 
 

  

Change Element Attributes
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MAKE REFERENCE FILES ACTIVE FOR MANIPULATION 

• This will allow you activate an attached reference file (dgn) to make 
changes to that reference. This is done without opening the reference file. 

• Open the References tool. 
  You will see a list of all attached references. 
 

 
 

• The third column in the tool box is the Activate Status setting. 
• Highlight the reference file you want to activate. 

 
• Double-click the highlighted file in 

the Activate Status column.(all other 
references become grayed out). 

 
• Elements in the activated reference 

file can now be modified, as if you 
had opened that file. 

 
• When finished, double-click the 

Activate Status column again to  
release the reference file.  You will 
be asked if you are sure you want to 
release the file; 
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Note that you will be unable to undo the changes 
you just made to the reference file. 
These changes are reflected in the activated  
reference and any other files with this file 
attached. 
 
If you do not “release” the activated reference 
file when exiting your file, the activated reference 
is considered to be an open dgn file. 
 
This would mean, the file would be read-only when you attempt to open the reference file 
directly.  
 

• Hit OK to release the file. 
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CHANGE REFERENCE FILE UPDATE SEQUENCE 
 
 
If your active and reference files are not updating in the correct order, 

(ex; your referenced sheet border is displayed on top of your design file elements and your 
active file elements)  you can change the order in which the files are updated. 

• Open the References tool. 

   You will see a list of all attached references. 

• Pull down Settings to Update Sequence. 

• Change the update sequence as 
desired by moving file up or down 
in the sequence.  The Slot 
number indicates the update 
order. 

• Usually, the border file is updated 
first, then the mapping file, 
design file, with the active (sheet) 
file updated last in the sequence. 

• Hit OK to accept the changes. 
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CHANGE UPDATE PRIORITY OF ACTIVE ELEMENTS 
 
Sometime you have to change the update sequence of your reference files (see previous 
slide), but when elements in your active file are not updating properly, you will need to 
change the priority of the elements themselves.  
 

In this case, you see a 
planimetric element is falling on 
top of a station call out.  Both 
elements are in the active dgn. 

 
         To change priority of the station 

call-out,   
 Go to Settings > Levels > Manager 

 
Identify the level of the element 

 you want to bring forward. (AUX01 
 here) 

 
Right-click the level, pull down to 
Properties. 

 

 

 

 

• Pull down Priority, and assign a higher value to the element. 
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• Hit Apply > OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can see the station call-out is now in front of the other element. 
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V8i TEXT LOOKS SHADED OR GRAYED OUT 
 
Microstation V8i display settings make text look fuzzy, shaded, or grayed out. (when zoomed 
out to a certain view)  You can change the preference to make the text ALWAYS show 
clearly at any zoom level.  
 

 Go to Workspace > Preferences > View Options. 
 
 
 
 
 
 
        Toggle Anti-alias Text to OFF.  
 
        Hit OK. 
 
        Update the View. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

[Type	text]	 Page	2‐59	
 

EFLHD CADD Procedures Guide – GEOPAK V8i Edition 
Chapter 2 –                        
GEOPAK V8i ‐ EFLHD Procedures

 
 
 
QUICKLY SET ACTIVE ATTRIBUTES 

Set active element attributes; level, color, style, weight, and line style) in Microstation V8i by using 
the ALT key. 
 

• Hold the ALT key while data pointing on an element you want the active settings to be 
changed to.  
 

• One data point changes the level, color, style, weight, and line style setting to the same as 
the element selected. 

 

 

 

QUICKLY FIND ELEMENT INFORMATION 

Rather than using the Element > Information tool.  Simply hold the ALT key and hit your 
mouse RESET button while hovering over the element you want info on. 
 

• A dialog will open, displaying the element information. 
 

• You can also edit some of the element information here.  
 

 

 

 

 

 

QUICKLY FIT THE VIEW 

Double-click the middle button (on a three button mouse) to quickly perform a “fit view”. 
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MAP A MOUSE BUTTON TO CLEAR A SELECTION SET 

Microstation V8i uses the power selector exclusively, sometimes an element from a previous 
command will still be selected when the user selects a new element and performs another 
action. The user may not be aware that the previous element was also modified. This button 
assignment allows the user to hit a mouse button and automatically deselect everything 
before performing a new task. 
 

• Go to Workspace > Button Assignments.  
 

• Select an empty button and, under Action, 
   type in “choose none” (without the quotation 

    marks) 
 

• Hit Remap Buttons. 
 

 

 
 
 
 
 
 
 
Select the button you chose in the  
previous window, hover the mouse 
over the Button Definition Area, 
and click the button you wish to  
use for this command. 
The small button on the left of a 
new Logitech mouse, (the one under 
your thumb) work well for this. 
 
 
WARNING: if you choose a button already being used for something else (like the left or 
right mouse button), whatever function it did before will now be assigned to this new button.  
 
You should now be able to use the extra mouse button to deselect everything. You can 
similarly map any other key‐in’able command to the extra mouse buttons. 
 
 
 


